
CHÖÔNG X. 
LAØM VIEÄC VÔÙI LÔÙP

Nhö ta ñaõ bieát, baûn ñoà soá cuûa moät khu vöïc thöôøng ñöôïc chia thaønh töøng nhoùm
döïa theo tính chaát cuûa thoâng tin treân baûn ñoà vaø ñöôïc soá hoaù thaønh töøng baûng rieâng
bieät. Khi muoán hieån thò baûn ñoà ta chæ môû nhöõng lôùp caàn thieát ra maø thoâi. Treân menu
chính cuûa MapInfo, Layer Control (Kieåm soaùt lôùp) laø leänh cho pheùp kieåm soaùt vieäc
hieån thò caùc lôùp baûn ñoà. Ta seõ xem xeùt chi tieát leänh naøy. Leänh Layer Control coù taùc
duïng khi moät cöûa soå baûn ñoà naøo ñoù ñang ñöôïc kích hoaït.

X.1. CAÙC THIEÁT LAÄP CHUNG CUÛA CÖÛA SOÅ BAÛN ÑOÀ

X.1.1. Caùc thieát laäp chung

Tröôùc khi xem xeùt caùc lôùp baûn ñoà coù trong cöûa soå baûn ñoà cuõng nhö caùc ñieàu chænh
treân caùc lôùp, ta caàn bieát caùch ñieàu chænh caùc tính chaát chung cuûa moät cöûa soå baûn ñoà
tröôùc. Khi moät cöûa soå baûn ñoà ñang ñöôïc môû vaø ñang ñöôïc kích hoaït, ta coù theå ñieàu
chænh moät soá thuoäc tính cuûa cöûa soå baûn ñoà ñoù. Nhöõng ñieàu chænh naøy naèm trong leänh
Map > Options. Khi choïn leänh naøy hoäp thoaïi Map Options seõ môû (hình X.1), chuùng
goàm coù caùc noäi dung nhö sau:

- Map Units: choïn caùc ñôn vò tính toaùn trong cöûa soå baûn ñoà. Noù goàm coù 3 oâ:
+ Coordinates Untis: choïn ñôn vò tính toaï ñoä. Ñoái vôùi nhöõng baûn ñoà coù heä toaï ñoä

laø kinh ñoä/vó ñoä thì ñôn vò trong oâ naøy maëc nhieân laø degrees (ñoä) vaø khoâng theå
thay ñoåi ñöôïc. Tuy nhieân coù moät soá heä quy chieáu coù theå choïn ñôn vò trong oâ
naøy. Ví duï baûn ñoà coù heä quy chieáu laø UTM thì ta coù theå choïn ñôn vò trong oâ naøy
laø degrees hay meters (meùt). Ñoái vôùi nhöõng baûn ñoà coù heä quy chieáu thuoäc daïng
None-Earth (phi quaû ñaát) thì ñôn vò tính toaùn trong oâ naøy theo ñôn vò tính luùc
ñaêng kyù heä quy chieáu.

+ Distance Units: choïn ñôn vò tính khoaûng caùch treân baûn ñoà. Caùc ñôn vò thöôøng
ñöôïc söû duïng ôû nöôùc ta laø millimeters (milimeùt), centimeters (centimeùt), meters
(meùt) vaø kilometers (kiloâmeùt).

+ Area Units: laø oâ choïn ñôn vò tính dieän tích. Caùc ñôn vò tính dieän tích thöôøng ñöôïc
söû duïng ôû nöôùc ta laø square millimeters (milimeùt vuoâng), square centimeters
(centimeùt vuoâng), square meters (meùt vuoâng), hectares (heùcta) vaø square kilo-
meters (kilomeùt vuoâng).

- Display in Status Bar: laø oâ choïn thoâng tin hieån thò treân thanh traïng thaùi. Coù 3 tuyø
choïn: Zoom (Width) - hieån thò soá ño chieàu roäng cuûa cöûa soå baûn ñoà, Map Scale -
hieån thò tyû leä baûn ñoà vaø Cursor Location - hieån thò toaï ñoä taïi vò trí con troû chuoät.
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- Caùc phaàn coøn laïi cuûa hoäp thoaïi naøy laø Distance/Area Using, Apply Clip Region
Using, When Resizing Window, ... hoaøn toaøn gioáng vôùi hoäp thoaïi Map Window trong
phaàn Options > Preferences > Map Window ôû Chöông I, muïc I.2.2.

Löu yù raèng caùc thieát laäp trong phaàn Options > Preferences > Map Window laø caùc

thieát laäp coù taùc duïng treân taát caû caùc cöûa soå baûn ñoà khi ñöôïc môû ra. Trong khi ñoù caùc
thieát laäp trong hoäp thoaïi Map Options ôû ñaây chæ coù taùc duïng treân cöûa soå baûn ñoà ñang
ñöôïc kích hoaït. Nhöõng thieát laäp trong hoäp thoaïi naøy seõ ghi ñeø leân nhöõng thieát laäp trong
hoäp thoaïi Map Window ôû phaàn Preferences, coù nghóa laø giaû söû trong phaàn Preferences
ta choïn ñôn vò khoaûng caùch laø kiloâmeùt nhöng khi môû moät cöûa soå baûn ñoà ra ta vaøo hoäp
thoaïi Map Options vaø chænh laïi ñôn vò laø daëm chaúng haïn thì ñôn vò daëm seõ coù taùc duïng. 

X.1.2. Leänh Clip Region - Caét vuøng

Khi môû caùc lôùp ra treân cöûa soå baûn ñoà, nhieàu khi ta chæ muoán hieån thò moät vuøng naøo
ñoù maø thoâi chöù khoâng muoán noäi dung baûn ñoà chaïy saùt ra meùp cöûa soå baûn ñoà. Muoán
hieån thò noäi dung chæ cuûa moät khu vöïc naøo ñoù, ta phaûi coù moät vaät theå kieåu vuøng cuûa
khu vöïc muoán hieån thò. Caùch thöïc hieän leänh caét vuøng hieån thò nhö sau:

- Môû caùc lôùp baûn ñoà caàn hieån thò ra treân cöûa soå baûn ñoà.

- Choïn moät vuøng caàn hieån thò noäi dung trong vuøng ñoù. Vuøng ñoù coù theå laø moät vaät theå

Hình X.1. Hoäp thoaïi Map Options - ñieàu chænh caùc thieát laäp cuûa cöûa soå baûn ñoà.
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cuûa moät lôùp coù saün hay laø moät vuøng do ta veõ theâm vaøo lôùp Cosmetic.

- Töø menu chính choïn Map > Clip Region.

Taát caû caùc noäi dung naèm ngoaøi vuøng ñöôïc choïn ñeàu bò che ñi, chæ hieån thò laïi nhöõng
gì naèm trong ranh giôùi cuûa vuøng ñöôïc choïn (hình X.2).

Muoán taét chöùc naêng naøy ñi ta vaøo laïi menu Map choïn Clip Region Off, cöûa soå baûn
ñoà seõ ñöôïc phuïc hoài trôû laïi nguyeân traïng ban ñaàu. Neáu ta choïn moät vuøng khaùc roài chaïy

leänh Clip Region thì moät hoäp thoaïi môû ra (hình X.3) hoûi ta coù boû vuøng caét tröôùc vaø söû
duïng vuøng caét môùi ñöôïc choïn hay khoâng. Neáu khoâng muoán boû, ta choïn Cancel, neáu
muoán caét vuøng baèng vuøng môùi ta choïn Replace.

Leänh naøy chæ coù theå caét vuøng baèng moät vaät theå duy nhaát. Neáu ta duøng phím <Shift>
ñeå choïn nhieàu vaät theå moät luùc thì leänh naøy bò môø ñi vaø khoâng söû duïng ñöôïc. Clip
Region coù moät soá thieát laäp tuyø choïn ñöôïc ñieàu chænh trong hoäp thoaïi Map Options vaø
phaàn Options > Preferences, xem chi
tieát veà ñieàu chænh caùc thieát laäp cô
cheá caét vuøng trong Chöông I, muïc
I.2.2.

X.1. HOÄP THOAÏI Layer Control

Ta vaøo hoäp thoaïi Kieåm soaùt Lôùp
baèng caùch kích hoaït cöûa soå baûn ñoà
caàn ñieàu chænh roài choïn Map > Layer

Hình X.2. Leänh Clip Region cho pheùp hieån thò chæ moät vuøng treân baûn ñoà. 1: Tænh
Ngheä An naèm chung vôùi caùc tænh khaùc; 2: baûn ñoà ñöôïc caét bôûi tænh Ngheä An

Hình X.3. Thoâng baùo hoûi xoaù vuøng caét cuõ.
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Control hay nhaép chuoät choïn nuùt leänh Layer Control treân thanh coâng cuï Main.

Ñeå thöïc taäp phaàn naøy, haõy môû caùc lôùp sau ra: thanh_pho, giao_thong, song,
ranh_gioi, cac_tinh, vietnam_vung. Treân menu chính choïn Map > Layer Control. Hoäp
thoaïi Layer Control môû ra (hình X.4).

ÔÛ beân traùi laø phaàn Layer, lieät keâ danh saùch caùc lôùp ñang môû. Danh saùch naøy ñöôïc
hieån thò theo thöù töï töø treân xuoáng döôùi, coù nghóa laø teân lôùp naøo ôû treân thì lôùp ñoù ñöôïc
hieän phía treân. Tuyø theo töøng baûn ñoà maø thöù töï caùc lôùp naøy phaûi ñöôïc ñieàu chænh sao

cho hôïp lyù. Theo cheá ñoä maëc ñònh, lôùp kieåu vuøng seõ naèm döôùi cuøng roài ñeán lôùp kieåu
ñöôøng vaø treân cuøng laø lôùp kieåu ñieåm. Trong tröôøng hôïp hai hay nhieàu lôùp coù cuøng kieåu
thì ta phaûi choïn caùch saép xeáp lôùp sao cho hôïp lyù.

Trong ví duï naøy, ta thaáy coù hai lôùp kieåu vuøng laø lôùp cac_tinh vaø lôùp vietnam_vung.
Ta phaûi ñeå lôùp cac_tinh naèm treân vì neáu naèm döôùi thì noù seõ bò lôùp vietnam_vung che
khuaát.

Ta coù 3 lôùp kieåu ñöôøng trong ví duï naøy laø song, giao_thong vaø ranh_gioi. Chuùng
ta haõy phaân tích xem saép lôùp chuùng nhö theá naøo cho hôïp lyù. Lôùp ranh_gioi laø moät
ñöôøng töôïng tröng cho ranh giôùi laõnh thoå cuûa nöôùc Vieät Nam, ñöôøng giao thoâng hay
soâng suoái laø nhöõng ñöôøng hieän höõu thöïc söï vì vaäy chuùng phaûi naèm treân. Giöõa ñöôøng
giao thoâng vaø soâng suoái, ta thaáy raèng nhöõng choã naøo maø ñöôøng giao thoâng vaø soâng
suoái caét nhau thì ñöôøng giao thoâng phaûi naèm treân (vì choã caét nhau coù theå laø coù caàu
vaø caàu thì phaûi naèm treân soâng suoái). Nhö vaäy trong 3 lôùp kieåu ñöôøng ta neân saép lôùp
theo thöù töï töø treân xuoáng döôùi laø giao_thong, song vaø ranh_gioi.

thanh_pho laø lôùp kieåu ñieåm vaø caùc lôùp kieåu ñieåm ñöôïc ñaët treân cuøng. Khi coù nhieàu
lôùp kieåu ñieåm ñöôïc môû cuøng moät luùc, ta cuõng phaûi choïn caùch saép xeáp cho hôïp lyù.

Hình X.4. Hoäp thoaïi Layer Control lieät keâ caùc lôùp ñang ñöôïc
môû trong cöûa soå baûn ñoà ñang ñöôïc kích hoaït.

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com


Thöù töï caùc lôùp taát nhieân coøn phuï thuoäc vaøo noäi dung baûn ñoà ta muoán trình baøy.
Noäi dung caàn trình baøy phaûi ñöôïc hieån thò roõ nhaát.

Ñeå thay ñoåi thöù töï treân-döôùi cuûa moät lôùp, ta choïn teân lôùp ñoù roài nhaép chuoät vaøo
hai nuùt Up hay Down trong phaàn Reorder ñeå di chuyeån lôùp ñöôïc choïn leân hay xuoáng.
Ta cuõng coù theå ñi chuyeån lôùp nhanh hôn baèng caùch nhaép vaø giöõ chuoät traùi treân teân
cuûa moät lôùp vaø reâ chuoät ñeå di chuyeån lôùp ñoù leân hay xuoáng.

Treân cuøng cuûa taát caû caùc lôùp baûn ñoà ñang ñöôïc môû laø moät lôùp coù teân laø Cosmetic
Layer. Ñaây laø moät lôùp maëc ñònh luoân luoân hieån thò. Lôùp naøy coù taùc duïng nhö moät lôùp
boå sung cho pheùp theâm nhöõng phaàn khoâng nhaát thieát phaûi coù trong töøng lôùp (thöôùc
tyû leä, kim chæ nam,...) nhöng laïi caàn thieát khi in aán chaúng haïn. Cosmetic Layer coøn coù
taùc duïng nhö moät lôùp nhaùp cho pheùp ta theâm bôùt thoâng tin, chænh söûa tröôùc khi
chuyeån chuùng thöïc söï leân moät lôùp naøo khaùc. Cosmetic coù nghóa laø “trang ñieåm”. Caùc
vaät theå ñoà hoaï treân lôùp Cosmetic khoâng coù döõ lieäu.

X.2. THIEÁT LAÄP TÍNH CHAÁT CUÛA LÔÙP TRONG CÖÛA SOÅ BAÛN ÑOÀ

Treân hoäp thoaïi Layer Control, ôû beân phaûi teân cuûa moãi lôùp ta thaáy coù 4 oâ choïn töông
öùng vôùi caùc coät coù caùc bieåu töôïng töø traùi sang phaûi laø hình con maét, hình caây vieát, hình
muõi teân choïn vaø hình moät caùi nhaõn maøu vaøng. Caùc coät naøy cho pheùp ta choïn tính chaát
hieån thò cuûa moät lôùp. Ta baät/taét caùc oâ choïn naøy baèng caùch nhaép chuoät vaøo chuùng.

X.2.1. Hieån thò lôùp - OÂ Visible

Coät coù bieåu töôïng hình con maét laø coät hieån thò lôùp (Visible). Neáu ta taét choïn
trong oâ naøy ôû lôùp naøo thì lôùp ñoù seõ khoâng ñöôïc hieån thò treân cöûa soå baûn ñoà. Theo maëc
ñònh, lôùp Cosmetic Layer luoân luoân ñöôïc hieån thò treân cöûa soå baûn ñoà, ta khoâng theå thay
ñoåi ñaëc tính naøy vaø oâ choïn naøy ôû haøng Cosmetic Layer bò môø ñi.

X.2.2. Chænh söûa baûn ñoà - OÂ Editable

Coät coù hình caây vieát laø coät cho pheùp chænh söûa (Editable). Neáu haøng naøo ñöôïc
ñaùnh daáu choïn vaøo coät naøy thì lôùp baûn ñoà ñoù coù theå chænh söûa ñöôïc, töùc laø coù theå veõ
theâm/xoaù bôùt hay chænh söûa caùc vaät theå treân lôùp baûn ñoà ñoù. Vaøo moät thôøi ñieåm chæ coù
moät lôùp coù theå ñöôïc ñaùnh daáu choïn vaøo oâ naøy.

X.2.3. Choïn vaät theå treân baûn ñoà - OÂ Selectable

Coät thöù ba laø coät cho pheùp choïn noäi dung trong moät lôùp naøo ñoù (Selectable).
Lôùp naøo ñöôïc ñaùnh daáu vaøo oâ naøy thì ta coù theå choïn ñöôïc caùc vaät theå naèm trong lôùp
ñoù baèng coâng cuï choïn treân thanh coâng cuï Main. Khi ta môû caùc lôùp baûn ñoà thì maëc
ñònh oâ naøy luoân luoân ñöôïc baät. Ñaây laø moät tuyø choïn coù lôïi trong vieäc chænh söûa baûn
ñoà. Ta coù theå muoán moät lôùp hieån thò treân cöûa soå baûn ñoà nhöng khoâng muoán choïn
nhaàm vaøo caùc vaät theå treân lôùp ñoù vì ñang chænh söûa treân moät lôùp khaùc thì coù theå taét
tuyø choïn naøy ñi trong caùc lôùp chæ caàn hieån thò. Theo maëc ñònh khi nhieàu vaät theå thuoäc
nhieàu lôùp baûn ñoà naèm treân cuøng moät vò trí thì luùc choïn, vaät theå thuoäc lôùp treân cuøng seõ
ñöôïc choïn.
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X.2.4. Daùn nhaõn töï ñoäng - OÂ Automatic Labelling

Coät thöù tö laø coät daùn nhaõn töï ñoäng (Automatic labelling). Khi ñaùnh daáu choïn
vaøo oâ naøy thì nhaõn trong moät tröôøng naøo ñoù ôû haøng ñöôïc choïn seõ ñöôïc hieån thò. Ta seõ
thaûo luaän chi tieát leänh naøy trong phaàn Label. Khi ñieàu chænh caùc thieát laäp trong nuùt leänh
Label, ta phaûi ñaùnh daáu choïn vaøo oâ naøy thì caùc nhaõn môùi ñöôïc hieån thò. Neáu ta taét choïn
trong oâ naøy thì caùc nhaõn töï ñoäng seõ khoâng ñöôïc hieån thò treân cöûa soå baûn ñoà.

X.3. THEÂM/BÔÙT LÔÙP VAØO CÖÛA SOÅ BAÛN ÑOÀ HIEÄN HAØNH

ÔÛ goùc döôùi beân traùi cuûa hoäp thoaïi Layer Control laø phaàn Layers vôùi hai nuùt choïn
Add vaø Remove cho pheùp ta theâm/bôùt lôùp vaøo moät cöûa soå baûn ñoà. Nuùt Remove cho
pheùp loaïi lôùp ñöôïc choïn ra khoûi danh saùch hieån thò trong hoäp thoaïi naøy. Ta boû moät lôùp
ra khoûi danh saùch baèng caùch nhaép chuoät choïn lôùp ñoù roài nhaán nuùt Remove. Khi loaïi
moät lôùp ra khoûi danh saùch trong hoäp thoaïi Layer Control, lôùp baûn ñoà ñoù seõ bieán maát
treân cöûa soå baûn ñoà töông öùng. Löu yù raèng nuùt leänh naøy chæ loaïi moät lôùp baûn ñoà ñang
ñöôïc choïn ra khoûi cöûa soå hieän haønh maø thoâi, lôùp baûn ñoà ñoù khoâng bò ñoùng laïi maø vaãn
toàn taïi trong MapInfo. Nuùt Add laø nuùt ngöôïc laïi, cho pheùp ta theâm moät lôùp baûn ñoà vaøo
cöûa soå baûn ñoà ñang ñöôïc kích hoaït. Khi choïn nuùt naøy, hoäp thoaïi Add Layer môû ra (hình
X.5). Hoäp thoaïi naøy lieät keâ danh
saùch taát caû caùc lôùp baûn ñoà ñang
ñöôïc môû. Ta theâm moät lôùp baûn
ñoà vaøo baèng caùch choïn noù roài
nhaán nuùt Add.

Beân phaûi hoäp thoaïi Layer
Control coù moät soá nuùt leänh khaùc.
Hai nuùt leänh OK vaø Cancel naèm
treân cuøng, chuùng coù yù nghóa
töông töï nhö moïi hoäp thoaïi khaùc,
töùc OK laø chaáp nhaän caùc thieát laäp
trong hoäp thoaïi vaø Cancel laø huyû
boû caùc thieát laäp vöøa thöïc hieän.

X.4. THIEÁT LAÄP KIEÅU VAÄT THEÅ
HIEÅN THÒ CUÛA LÔÙP

Nuùt leänh Display cho pheùp chænh kieåu vaät theå hieån thò cuûa moät lôùp. Caùch laøm: choïn
teân lôùp ñoù trong danh saùch beân traùi roài nhaán vaøo nuùt Display. Hoäp thoaïi coù daïng <teân
lôùp ñöôïc choïn> Display Options môû ra (hình X.6).

Trong phaàn Display Mode ta coù theå chænh söûa kieåu vaät theå cuûa lôùp ñöôïc choïn. Tuyø
choïn Style Override theo maëc ñònh ñöôïc taét ñi. Neáu ta ñaùnh daáu choïn vaøo oâ naøy, nuùt
chænh kieåu vaät theå ôû döôùi seõ noåi roõ leân. Nuùt naøy laø nuùt chænh kieåu ñieåm, ñöôøng hay vuøng
tuyø thuoäc vaøo lôùp baûn ñoà ñang ñöôïc choïn. Ví duï neáu ta choïn lôùp song thì phaàn naøy seõ
laø nuùt chænh kieåu ñöôøng. Giaû söû ta nhaép chuoät choïn nuùt naøy vaø chænh kieåu ñöôøng cuûa
lôùp song thaønh maøu xanh döông chaúng haïn. Khi ta chænh kieåu vaät theå trong leänh naøy,
kieåu vaät theå goác cuûa lôùp baûn ñoà ñang ñöôïc choïn khoâng bò thay ñoåi gì caû. Söï thay ñoåi
chæ coù taùc duïng trong cöûa soå baûn ñoà ñang ñöôïc kích hoaït maø thoâi.

Hình X.5. Hoäp thoaïi Add Layer - Theâm lôùp.
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Phaàn tieáp theo laø phaàn Zoom Layering.
Phaàn naøy cho pheùp ta chænh cheá ñoä hieån
thò cuûa lôùp baûn ñoà ñang ñöôïc choïn trong
moät giôùi haïn ñoä phoùng ñaïi naøo ñoù. Theo
maëc ñònh, tuyø choïn naøy cuõng ñöôïc taét ñi.
Ñoä phoùng ñaïi trong hai oâ Min. Zoom vaø
Max. Zoom laø giaù trò töông öùng vôùi ñoä
phoùng ñaïi hieän treân thanh Traïng thaùi
(Status Bar) ngoaøi cöûa soå baûn ñoà. Giaù trò
hieån thò laø khoaûng caùch tính theo chieàu
ngang cuûa cöûa soå baûn ñoà hieän haønh. Khi ta
khai baùo giaù trò vaøo hai oâ naøy (Min. Zoom laø
ñoä phoùng ñaïi nhoû nhaát vaø Max. Zoom laø
lôùn nhaát) thì khi phoùng to hay thu nhoû baûn
ñoà ra ngoaøi khoaûng giôùi haïn ñöôïc khai baùo
thì lôùp baûn ñoà ñang ñöôïc choïn bò taét ñi.

Ñaây laø moät ñaëc tính cuõng khaù höõu ích
khi môû nhieàu lôùp baûn ñoà vôùi nhieàu möùc ñoä
chi tieát khaùc nhau. Ta coù theå chænh ñeå cho
nhöõng lôùp baûn ñoà naøo coù ñoä chi tieát cao
hieån thò ôû ñoä phoùng ñaïi lôùn (töùc giaù trò Min.
Zoom vaø Max. Zoom nhoû). Nhôø ñoù khi thu
nhoû baûn ñoà thì lôùp baûn ñoà quaù chi tieát ñoù
seõ ñöôïc taét ñi ñeå traùnh laøm roái baûn ñoà.

Phaàn döôùi cuøng cuûa hoäp thoaïi Display
Options laø 3 tuyø choïn khaùc. Theo maëc ñònh
3 tuyø choïn naøy ñeàu taét.

Show Line Direction hieån thò muõi teân chieàu veõ cuûa caùc ñöôøng. Leänh naøy khoâng coù
taùc duïng treân caùc vaät theå kieåu ñieåm vaø kieåu vuøng.

Show Nodes hieån thò caùc noát (töùc caùc ñieåm ñoåi höôùng, laø caùc ñieåm nhaép chuoät
trong quaù trình veõ). Leänh naøy khoâng coù taùc duïng treân caùc vaät theå kieåu ñieåm.

Show Centroids hieån thò troïng taâm cuûa caùc vuøng. Khi hieån thò troïng taâm vaø lôùp hieån
thò ñang ôû cheá ñoä chænh söûa thì ta coù theå thay ñoåi troïng taâm cuûa caùc vaät theå neáu muoán.
Söï thay ñoåi troïng taâm coù lôïi trong vieäc daùn nhaõn caùc vaät theå kieåu vuøng vaø moät soá leänh
khaùc. Chi tieát phaàn naøy ñaõ ñöôïc trình baøy trong Chöông V, muïc V.1.2.2.

X.5. NUÙT LEÄNH Label - Daùn nhaõn töï ñoäng

Nuùt leänh tieáp theo trong hoäp thoaïi Layer Control laø nuùt leänh Label. Nuùt leänh naøy
cho pheùp ta daùn nhaõn töï ñoäng caùc lôùp baûn ñoà. Choïn lôùp baûn ñoà caàn daùn nhaõn roài
nhaép chuoät vaøo nuùt Label, hoäp thoaïi Label Options môû ra (hình X.7).

Phaàn treân cuøng laø oâ Label with. Baám chuoät choïn muõi teân thaû xuoáng beân phaûi
oâ naøy seõ môû ra danh saùch caùc tröôøng coù trong lôùp ñöôïc choïn ñeå daùn nhaõn. Nhaép
chuoät choïn tröôøng caàn daùn nhaõn, teân tröôøng ñoù seõ xuaát hieän trong oâ Label with.

Phaàn cuoái cuøng trong menu thaû xuoáng cuûa oâ Label with laø tuyø choïn Expressions

Hình X.6. Hoäp thoaïi Display Options,
choïn kieåu vaät theå hieån thò trong
cöûa soå baûn ñoà.
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(Bieåu thöùc). Bieåu thöùc cho pheùp ta daùn nhaõn töø nhieàu tröôøng ñoàng thôøi coù theå theâm
caùc chöõ vaøo ñeå boå sung cho nhaõn. Ñeå daùn nhaõn baèng bieåu thöùc, nhaép chuoät vaøo chöõ
Expression, hoäp thoaïi Expression môû ra, goõ noäi dung caàn daùn nhaõn vaøo oâ Type an
Expression. Ví duï trong baûng cac_tinh coù tröôøng ten vaø tröôøng dien_tich, muoán daùn
nhaõn leân baûn ñoà vöøa teân vöøa dieän tích ta goõ vaøo hoäp thoaïi Expression nhö sau:

ten + dien_tich

Giaû söû vôùi tænh Ñaék Laék, nhaõn hieän ra seõ laø:

Ñaék Laék19,800
Teân tænh vaø dieän tích dính chung vôùi nhau. Ñeå taùch teân vaø dieän tích ra, ta theâm vaøo

giöõ hai teân tröôøng moät daáu phaåy, bieåu thöùc seõ laø:

ten + “, “ + dien_tich

(sau daáu phaåy laø moät khoaûng traéng)

Nhaõn seõ trôû thaønh:

Hình X.7. Hoäp thoaïi Label Options, cho pheùp ñieàu chænh caùc thieát laäp veà nhaõn.
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Ñaék Laék, 19,800
Dieän tích tính baèng km vuoâng, neáu muoán chæ roõ ñieàu ñoù ta theâm chöõ “dieän tích”

vaøo tröôùc tröôøng dien_tich vaø theâm chöõ “km vuoâng” vaøo sau tröôøng dieän tích nhö sau:

ten + “, dieän tích: “ + dien_tich + “km vuoâng”

Nhaõn seõ trôû thaønh:

Ñaék Laék, dieän tích: 19,800 km vuoâng
Neáu muoán xuoáng haøng choã naøo, ta theâm kyù töï xuoáng haøng vaøo choã ñoù. Kyù töï

xuoáng haøng coù maõ ANSI laø 13. Ví duï ta muoán nhaõn hieän leân baûn ñoà laø teân, sau ñoù
xuoáng haøng vaø hieän leân dieän tích, thì trong Bieåu thöùc ta goõ nhö sau:

ten + chr$(13) + ”Dieän tích: “ + dien_tich + “km vuoâng”

nhaõn treân baûn ñoà seõ trôû thaønh:

Ñaék Laék
Dieän tích: 19,800 km vuoâng

X.5.1. Cheá ñoä hieån thò nhaõn - phaàn Visibility

Phaàn tieáp theo trong hoäp thoaïi Label Options laø Visibility, duøng ñeå chænh cheá ñoä
hieån thò cuûa nhaõn. Ñaàu tieân ta coù hai tuyø choïn laø On (baät) vaø Off (taét) duøng ñeå baät/taét
nhaõn. Tuyø choïn Display Within Range töông töï nhö phaàn Display trong hoäp thoaïi Layer
Control, cho pheùp hieån thò nhaõn ôû moät giôùi haïn ñoä phoùng ñaïi naøo ñoù cuûa baûn ñoà. Neáu
giôùi haïn naøy naèm ngoaøi khoaûng giôùi haïn Display cuûa lôùp baûn ñoà ñang ñöôïc choïn thì
coù theå lôùp baûn ñoà ñoù hieån thò nhöng nhaõn laïi khoâng hieån thò. Trong tröôøng hôïp ñoù daáu
choïn trong muïc Display Within Range seõ coù maøu magenta (maøu hoàng ñaäm) ñeå thoâng
baùo cho ta bieát.

Beân phaûi hoäp thoaïi Label Options coù caùc tuyø choïn Allow Duplicate Text, Allow
Overlapping text, Label Partial Segments vaø oâ Maximun Labels. Theo maëc ñònh chæ coù
tuyø choïn Allow Duplicate Text ñöôïc ñaùnh daáu. Neáu tuyø choïn naøy ñöôïc ñaùnh daáu thì
ta coù theå daùn cuøng moät nhaõn nhieàu laàn treân moät baûn ñoà.

Allow Overlapping Text cho pheùp caùc nhaõn gaàn nhau ñöôïc hieån thò choàng leân
nhau. Neáu tuøy choïn naøy taét thì neáu caùc nhaõn hieån thò treân cuøng moät vò trí thì chæ coù
moät nhaõn hieän ra maø thoâi.

Label Partial Segments cho pheùp hieån thò nhaõn cuûa nhöõng vaät theå maø chæ coù moät
phaàn nhoû cuûa vaät theå ñoù hieän dieän trong cöûa soå baûn ñoà hieän haønh. Ñaëc tính naøy chæ
aùp duïng cho vieäc daùn nhaõn töï ñoäng. Ngoaøi ra neáu ta ñieàu chænh moät nhaõn thì vò trí cuûa
nhaõn khoâng theå thay ñoåi ñöôïc neáu tuyø choïn naøy ñöôïc baät leân.

Maximum Label cho pheùp hieån thò moät soá löôïng nhaõn nhaát ñònh treân baûn ñoà. Ta
goõ soá löôïng nhaõn maø ta muoán hieån thò vaøo oâ naøy. Caùc nhaõn ñöôïc hieån thò laø nhöõng
nhaõn naèm theo thöù töï töø treân xuoáng döôùi trong cöûa soå döõ lieäu cuûa lôùp baûn ñoà ñoù trong
quaù trình nhaäp lieäu. Giaû söû nhö neáu ta goõ vaøo soá 15 thì seõ coù nhaõn cuûa 15 haøng ñaàu
tieân baûng döõ lieäu ñöôïc hieån thò.

X.5.2. Ñònh daïng nhaõn - phaàn Styles
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Phía döôùi beân traùi cuûa hoäp thoaïi Label Options laø Styles, duøng ñeå ñònh daïng nhaõn.
Nuùt choïn kieåu chöõ cho ta vaøo hoäp thoaïi chænh kieåu chöõ cho nhaõn. Phía döôùi nuùt chænh
kieåu chöõ laø tuyø choïn Label lines (ñöôøng chæ nhaõn). Coù 3 tuyø choïn, None laø khoâng hieån
thò ñöôøng chæ; Simple cho pheùp hieån thò moät ñöôøng thaúng töø nhaõn ñeán vaät theå ñöôïc
daùn nhaõn; Arrow hieån thò muõi teân chæ töø nhaõn ñeán vaät theå ñöôïc daùn nhaõn. Beân phaûi 3
tuyø choïn naøy laø nuùt chænh kieåu ñöôøng cuûa ñöôøng chæ.

X.5.3. Quy ñònh vò trí nhaõn - phaàn Position

Phía döôùi beân phaûi cuûa hoäp thoaïi Label Options laø muïc Position, choïn vò trí hieån
thò cuûa nhaõn. Phaàn naøy cho pheùp chænh vò trí cuûa nhaõn so vôùi vaät theå ñöôïc daùn nhaõn.
Muïc Anchor Point cho pheùp choïn vò trí töông ñoái cuûa nhaõn so vôùi ñieåm neo (anchor
point) cuûa vaät theå ñöôïc daùn nhaõn. Ñieåm neo cuûa vaät theå ñieåm chính laø vaät theå ñoù,
ñieåm neo cuûa vaät theå vuøng laø troïng taâm cuûa vaät theå ñoù, ñieåm neo cuûa ñöôøng naèm ôû
chính giöõa cuûa phaàn ñöôøng ñang ñöôïc hieån thò treân cöûa soå baûn ñoà hieän haønh. Coù 9
vò trí ñöôïc bieåu thò baèng 9 nuùt, hình chöõ nhaät maøu ñoû töôïng tröng cho vò trí nhaõn vaø
hình thoi maøu xanh töôïng tröng cho ñieåm neo cuûa vaät theå ñöôïc daùn nhaõn. Vò trí nhaõn
ñöôïc choïn baèng caùch nhaép chuoät vaøo moät trong 9 nuùt vò trí tuyø choïn treân. Döôùi muïc
Anchor Point laø tuyø choïn Rotate Label with Line. Tuyø choïn naøy cho pheùp ta hieån thò
nhaõn xoay doïc theo vaät theå kieåu ñöôøng. Cuoái cuøng laø oâ Label Offset, tính baèng point.
OÂ naøy cho pheùp ta xaùc ñònh khoaûng caùch (tính theo point) töø nhaõn ñeán ñieåm neo. Giaù
trò maëc ñònh laø 2 point.

X.5.4. Daùn nhaõn thuû coâng - nuùt leänh Label

Trong haàu heát caùc tröôøng hôïp trình baøy baûn ñoà ta coù theå söû duïng chöùc naêng daùn
nhaõn töï ñoäng cuûa nuùt leänh Label trong hoäp thoaïi Layer Control. Tuy nhieân trong moät
soá tröôøng hôïp, ta coù theå chæ muoán daùn nhaõn moät vaøi vaät theå treân baûn ñoà chöù khoâng
phaûi taát caû vaät theå trong moät baûng. Trong tröôøng hôïp ñoù, söû duïng nuùt leänh Label treân
thanh coâng cuï Drawing tieän lôïi hôn. Caùch thöïc hieän daùn nhaõn thuû coâng nhö sau:

- Kích hoaït cöûa soå baûn ñoà coù lôùp muoán daùn nhaõn thuû coâng.

- Töø menu chính choïn Map > Layer Control. Hoäp thoaïi Layer Control môû ra.

- Choïn baûng muoán daùn nhaõn thuû coâng roài choïn nuùt Label. Hoäp thoaïi Label Options
môû ra.

- Choïn tröôøng ñeå daùn nhaõn trong oâ Label with cuûa hoäp thoaïi Label Options. Laäp bieåu
thöùc neáu caàn thieát.

- Thieát laäp caùc thuoäc tính cuûa nhaõn nhö trong caùc muïc töø X.5.1 ñeán X.5.3 ôû treân.

- Choïn OK ñeå quay trôû laïi hoäp thoaïi Layer Control.
- Khoâng ñaùnh daáu vaøo oâ daùn nhaõn töï ñoäng, choïn OK ñeå quay laïi cöûa soå baûn ñoà.

- Choïn nuùt leänh Label (hình caùi nhaõn maøu vaøng) treân thanh coâng cuï Drawing.

- Di chuyeån chuoät trôû laïi cöûa soå baûn ñoà, nhaép chuoät leân vaät theå naøo ta muoán daùn
nhaõn thì nhaõn seõ xuaát hieän treân vaät theå ñoù.

Ñoái vôùi leänh daùn nhaõn töï ñoäng, neáu muoán taét nhaõn treân cöûa soå baûn ñoà, vaøo hoäp
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thoaïi Layer Control vaø taét choïn trong oâ Automatic Labelling ñi. Ñoái vôùi nhaõn thuû coâng,
neáu muoán taét moät nhaõn, choïn nhaõn ñoù roài nhaán phím <Delete> (giöõ phím <Shift> ñeå
choïn nhieàu nhaõn moät luùc). Neáu muoán taét taát caû caùc nhaõn ñöôïc daùn baèng phöông phaùp
thuû coâng, töø menu chính choïn Map > Clear Custom Labels. Moät cöûa soå MapInfo môû
ra yeâu caàu ta khaúng ñònh laïi laàn nöõa muoán xoaù caùc nhaõn thuû coâng, choïn Discard vaø
taát caû caùc nhaõn ñöôïc daùn baèng phöông phaùp thuû coâng ñeàu bò xoaù ñi. Löu yù raèng caùc
nhaõn ñöôïc daùn baèng phöông phaùp daùn nhaõn töï ñoäng neáu bò thay ñoåi treân cöûa soå baûn
ñoà sau ñoù (nhö di chuyeån, chænh kieåu chöõ laïi,...) thì khi taét leänh daùn nhaõn töï ñoäng ñi
nhöõng nhaõn naøy khoâng maát ñi vì khi chænh söûa baèng tay MapInfo ñaõ coi chuùng laø nhaõn
thuû coâng. Muoán xoaù chuùng ta phaûi söû duïng caùch xoaù nhö ñoái vôùi nhaõn thuû coâng.

X.6. NUÙT Thematic TRONG MENU Layer Control

Nuùt leänh naøy cho pheùp ta vaøo hoäp thoaïi chænh söûa Thematic Layer, töùc lôùp baûn ñoà
chuû ñeà. Nuùt leänh naøy chæ hieän roõ khi coù moät lôùp baûn ñoà chuû ñeà naøo ñoù ñöôïc taïo ra
tröôùc ñoù. Xem chi tieát caùch taïo baûn ñoà chuû ñeà vaø chænh söûa trong Chöông XIII.

X.7. HOTLINK (Lieân keát Noùng)

Ñaây laø moät nuùt leänh ñaëc bieät cho pheùp ta thöïc hieän lieân keát vôùi moät taäp tin khaùc
hay moät ñòa chæ treân maïng. Khi moät vaät theå baûn ñoà ñöôïc lieân keát vôùi moät URL (ñòa chæ
treân maïng - vieát taét cuûa chöõ Uniform Resource Locator) hay moät taäp tin khaùc thì vaät
theå ñoù trôû thaønh moät vaät theå ñöôïc kích hoaït (active object). Nhaép chuoät vaøo vaät theå
chuû ñoäng baèng nuùt coâng cuï Hotlink (treân thanh coâng cuï Main) seõ khôûi ñoäng taäp
tin hay ñòa chæ treân maïng töông öùng. Ñeå lieân keát moät vaät theå baûn ñoà vôùi moät taäp tin
hay moät ñòa chæ treân maïng tröôùc tieân phaûi taïo ñöôøng daãn ñeán taäp tin hay ñòa chæ ñoù.
Caùc böôùc tieán haønh nhö sau:

- Môû moät baûng cuûa MapInfo coù chöùa caùc vaät theå maø ta muoán lieân keát.

- Taïo moät tröôøng môùi coù ñònh daïng laø kieåu kyù töï (Character). Löu yù raèng kích thöôùc
tröôøng phaûi ñuû daøi ñeå ñuû chöùa ñöôøng daãn maø ta seõ naïp vaøo sau naøy.

- Sau khi taïo tröôøng môùi xong, môû cöûa soå Browser cuûa baûng ñoù ra vaø naïp ñöôøng daãn
ñeán taäp tin hay ñòa chæ maø ta muoán haøng ñoù lieân keát vaøo.

Ñeå chaïy lieân keát noùng, tieán haønh caùc böôùc sau:

- Môû lôùp baûn ñoà ñaõ taïo tröôøng vaøo moät cöûa soå baûn ñoà ñang ñöôïc kích hoaït hay kích
hoaït cöûa soå baûn ñoà coù chöùa baûng maø ta ñaõ taïo lieân keát.

- Choïn Map > Layer Control.
- Trong hoäp thoaïi Layer Control, choïn lôùp baûn ñoà coù lieân keát vaø nhaép chuoät choïn nuùt

HotLink. Löu yù raèng nuùt leänh naøy khoâng coù taùc duïng khi ta choïn moät lôùp baûn ñoà
chuû ñeà (thematic map), moät lôùp kieåu löôùi (grid) hay lôùp Cosmetic.

- Nhaép chuoät vaøo nuùt menu thaû xuoáng trong oâ Filename Expression vaø choïn teân
tröôøng maø ta ñaõ taïo ra trong böôùc ñaàu. Neáu vò trí cuûa caùc taäp tin lieân quan vôùi vaät
theå baûn ñoà laø vò trí töông ñoái so vôùi baûng chöùa caùc vaät theå ñoù thì ta ñaùnh daáu choïn
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vaøo oâ File locations are relative to table location.

- Ñaùnh daáu choïn vaøo moät trong ba tuyø choïn Labels, Objects hay Label & Objects. Caùc
tuyø choïn naøy seõ quyeát ñònh vieäc caùc vaät theå ñöôïc kích hoaït nhö theá naøo ñeå lieân keát
vôùi taäp tin hay ñòa chæ treân maïng.

- Ta coù theå ñaùnh daáu choïn vaøo oâ Save Options to table metadata neáu muoán lieân keát
noùng naøy ñöôïc töï ñoäng kích hoaït khi môû lôùp baûn ñoà ñoù ra.

Lieân keát noùng coù theå ñöôïc söû duïng töø cöûa soå Browser hay cöûa soå baûn ñoà.

X.7.1. Söû duïng lieân keát noùng töø cöûa soå Browser

Nuùt leänh HotLink söû duïng ñöôïc trong moät cöûa soå Browser khi baûng MapInfo maø ta
ñang môû döõ lieäu ñoù coù thieát laäp HotLink ñaõ ñöôïc löu trong metadata. Neáu moät tröôøng
naøo ñoù coù teân truøng vôùi teân tröôøng ñaõ ñöôïc choïn trong hoäp thoaïi HotLink Options thì
bieåu thöùc ñöôøng daãn trong tröôøng ñoù seõ ñöôïc gaïch döôùi vaø nuùt leänh HotLink treân
thanh coâng cuï Main coù theå söû duïng ñöôïc (hieän roõ leân). Nhaép chuoät choïn nuùt leänh
HotLink roài di chuyeån chuoät veà cöûa soå Browser vaø nhaép chuoät vaøo ñöôøng daãn gaïch
döôùi trong cöûa soå Browser seõ khôûi ñoäng ñòa chæ treân maïng hay taäp tin töông öùng trong
ñöôøng daãn.

Ñeå thöïc hieän lieân keát noùng trong cöûa soå Browser, thöïc hieän nhöõng böôùc sau:

- Tröôùc tieân thieát laäp HotLink trong hoäp thoaïi HotLink Options vaø löu chuùng vaøo meta-
data (xem phaàn treân).

- Môû baûng coù chöùa lieân keát noùng ñaõ ñöôïc taïo vaøo cöûa soå baûn ñoà hieän haønh.

- Môû cöûa soå Browser cuûa lôùp baûn ñoà ñoù baèng leänh Window > New Browser Window
vaø choïn lôùp baûn ñoà caàn thöïc hieän HotLink.

Neáu bieåu thöùc chæ teân ñöôøng daãn (Filename Expression) cuûa HotLink laø teân tröôøng
cuûa baûng thì noäi dung trong tröôøng ñoù seõ ñöôïc gaïch döôùi. Neáu bieåu thöùc chæ ñöôøng
daãn ôû daïng phöùc taïp hôn thì ta phaûi taïo tröôøng lieân keát noùng baèng caùc böôùc sau:

- Choïn Browse > Pick Fields (nhôù kích hoaït cöûa soå Browser tröôùc).

- Trong hoäp thoaïi Pick Fields, ôû oâ Fields in Table list choïn muïc Expression, hoäp thoaïi
Expression seõ môû ra.

- Trong hoäp thoaïi Expression goõ Bieåu thöùc chæ teân ñöôøng daãn ñeán lieân keát noùng
(HotLink Filename Expression) roài choïn OK hai laàn.

- Noäi dung trong tröôøng môùi seõ ñöôïc gaïch döôùi vaø nuùt leänh HotLink seõ coù taùc duïng.

X.7.2. Söû duïng lieân keát noùng töø cöûa soå baûn ñoà

Leänh HotLink coù taùc duïng trong cöûa soå baûn ñoà khi cöûa soå baûn ñoà ñoù coù chöùa ít
nhaát moät lôùp chuû ñoäng (active layer). Moät lôùp ñöôïc goïi laø chuû ñoäng khi lôùp ñoù ñöôïc
ñaùnh daáu coù theå choïn hay coù theå chænh söûa trong Layer Control vaø caùc tuyø choïn
HotLink ñaõ ñöôïc thieát laäp trong hoäp thoaïi HotLink Options (ñaëc bieät laø muïc Filename
Expression trong hoäp thoaïi ñoù).

Ñeå khôûi ñoäng lieân keát noùng ñeán moät ñòa chæ maïng (URL) hay moät taäp tin treân cöûa
soå baûn ñoà, ta thöïc hieän caùc böôùc sau:
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- Nhaép chuoät choïn nuùt lieân keát noùng treân thanh coâng cuï Main. Con troû chuoät
bieán thaønh hình baøn tay.

- Khi di chuyeån con troû chuoät ñeán vò trí cuûa moät vaät theå chuû ñoäng, con troû chuoät bieán
thaønh hình baøn tay giöõ hình tia chôùp. Lieân keát cuûa vaät theå ñoù ñöôïc hieån thò treân
Thanh Traïng thaùi (Status Bar).

- Nhaép chuoät leân vaät theå ñoù hay leân nhaõn cuûa noù seõ khôûi ñoäng lieân keát ñeán taäp tin
hay ñòa chæ treân maïng ñaõ ñöôïc thieát laäp cho vaät theå ñoù. Neáu coù nhieàu vaät theå naèm
choàng leân nhau taïi vò trí maø ta nhaép chuoät thì seõ coù moät cöûa soå nhaéc môû ra cho
pheùp ta choïn töø danh saùch caùc vaät theå taïi ñieåm nhaép chuoät. Choïn vaät theå maø ta
muoán khôûi ñoäng lieân keát.

Ta seõ xem xeùt moät tình huoáng cuï theå döôùi ñaây.

Ta ñaõ coù lôùp baûn ñoà 61 tænh thaønh cuûa nöôùc ta. Giaû söû moãi tænh hay thaønh phoá coù
moät taám aûnh soá trong maùy tính. Ta muoán raèng khi söû duïng leänh HotLink nhaép chuoät
leân tænh (hay teân tænh) naøo thì maùy tính seõ môû hình cuûa tænh ñoù ra. Caùch laøm nhö sau:

- Môû lôùp baûn ñoà cac_tinh ra.

- Choïn Table > Maintenance > Table Structure > choïn lôùp baûn ñoà caùc tænh trong hoäp
thoaïi View/Modify Table Structure.

- Trong hoäp thoaïi Modify Table Structure, choïn nuùt Add Field.

- Söûa teân tröôøng môùi maëc ñònh trong oâ Name cuûa phaàn Field Information thaønh
Hinh_anh (hình aûnh), choïn kieåu tröôøng trong oâ Type laø Character (kieåu kyù töï) vaø
ñònh kích thöôùc tröôøng trong oâ Width laø 50. Caàn nhôù raèng chieàu roäng cuûa tröôøng
phaûi ñuû daøi ñeå chöùa teân ñöôøng daãn ñeán thö muïc chöùa hình aûnh maø ta seõ naïp vaøo
sau naøy.

- Choïn OK ñeå hoaøn taát böôùc taïo tröôøng môùi.

- Choïn Window > New Browser Window > choïn lôùp cac_tinh trong hoäp thoaïi Browse
Table trong tröôøng hôïp ta môû nhieàu lôùp. Neáu chæ môû moät lôùp cac_tinh thì hoäp thoaïi
naøy khoâng hieän ra maø cöûa soå Browse cuûa lôùp cac_tinh seõ môû ra ngay.

- Chænh kieåu chöõ trong cöûa soå Browse laïi cho ñuùng thaønh kieåu chöõ tieáng Vieät (kieåu
VNI-Helve chaúng haïn) baèng nuùt chænh kieåu chöõ treân thanh coâng cuï Drawing.

Ñeå deã quan saùt, ta chæ ñeå laïi hai tröôøng laø ten vaø Hinh_anh, caùch laøm nhö sau:

- Treân menu chính choïn Browse > Pick Fields
- Trong hoäp thoaïi Pick Fields, ôû oâ Columns in Browser, ta choïn caùc tröôøng khaùc roài

nhaán nuùt Remove ñeå loaïi chuùng ra khoûi cöûa soå Browser, chæ ñeå laïi hai tröôøng laø ten
vaø Hinh_anh. Laøm xong choïn OK.

- Naïp ñöôøng daãn ñeán caùc taäp tin hình aûnh: Giaû söû ta coù moät taám hình chuïp thaønh
phoá Haø Noäi, teân taäp tin laø HN.jpg; taäp tin naøy naèm trong oå ñóa E, thö muïc Vietnam,
thö muïc con Hinh_anh. Tìm ñeán haøng coù chöõ “Haø Noäi” treân cöûa soå Browse, vaø naïp
doøng sau ñaây vaøo tröôøng Hinh_anh:

E:\Vietnam\Hinh_anh\HN.jpg

Töông töï nhö vaäy ta naïp ñöôøng daãn ñeán hình aûnh cuûa caùc tænh khaùc vaøo tröôøng
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Hinh_anh, neáu coù (hình X.8).

Thöïc hieän leänh HotLink nhö
sau:

- môû cöûa soå baûn ñoà cuûa lôùp
cac_tinh ra baèng leänh Map
> New Map Window.

- Kích hoaït cöûa soå baûn ñoà coù
lôùp cac_tinh (neáu caàn) roài
choïn Map > Layer Control.

- Treân hoäp thoaïi Layer
Control, choïn lôùp cac_tinh
roài choïn nuùt HotLink.

- Treân hoäp thoaïi cac_tinh
HotLink Options, trong oâ
Filename Expression choïn
tröôøng Hinh_anh; trong
phaàn Activate HotLink on, choïn Labels & Objects. Neáu ta choïn moät trong hai tuyø
choïn kia laø Labels hay Objects thì leänh naøy chæ coù taùc duïng khi nhaép chuoät töông
öùng treân Nhaõn (Labels) hay treân vaät theå (Objects).Laøm xong choïn OK.

- Ñaùnh daáu choïn vaøo coät daùn nhaõn töï ñoäng ôû haøng cac_tinh, nhaép chuoät choïn
nuùt Label.

- Trong hoäp thoaïi Label Options, trong oâ Label with, choïn tröôøng ten. Chænh caùc thieát
laäp khaùc nhö kieåu chöõ, vò trí nhaõn, ñöôøng chæ nhaõn,... theo yù muoán (xem phaàn nuùt
leänh Label ôû treân).

- Laøm xong choïn OK ñeå ñoùng hoäp thoaïi Label Options laïi roài choïn OK laàn nöõa ñeå
ñoùng hoäp thoaïi Layer Control laïi.

Luùc naøy ta thaáy treân thanh coâng cuï Main, nuùt leänh HotLink coù hình tia chôùp maøu
vaøng ñaõ hieän roõ.

- Nhaép chuoät choïn nuùt HotLink, di chuyeån chuoät trôû laïi cöûa soå baûn ñoà, con troû chuoät
bieán thaønh hình baøn tay. Khi di chuyeån ñeán tænh naøo ñaõ coù naïp ñöôøng daãn ñeán taäp
tin hình aûnh thì hình baøn tay seõ bieán thaønh hình baøn tay caàm tia chôùp. Neáu nhaép
chuoät thì hình aûnh cuûa tænh ñoù seõ môû ra.

Löu yù raèng khi taïo ñöôøng daãn ñeán moät taäp tin naøo ñoù caàn ñaûm baûo raèng treân maùy
tính phaûi coù phaàn meàm môû ñöôïc taäp tin ñoù, neáu khoâng thì taäp tin ñoù khoâng môû ñöôïc. 

Töông töï nhö treân ta coù theå taïo ñöôøng daãn ñeán moät ñòa chæ trang web naøo ñoù. Giaû
söû coù moät trang web veà caùc tænh cuûa nöôùc ta, moãi tænh coù moät ñòa chæ trong trang web
ñoù, ta coù theå taïo ñöôøng daãn cho HotLink, ví duï ñeán trang thoâng tin veà Haø Noäi, nhö
sau:

http://www.vietnam.com.vn/ha_noi.html

Ví duï treân laø ñöôøng daãn ñeán trang web Vieät Nam vaø daãn ñeán taäp tin coù ñuoâi môû
roäng laø .html veà thaønh phoá Haø Noäi. Löu yù raèng trang web naøy chæ laø ví duï, khoâng coù
thöïc.

Hình X.8. Naïp ñöôøng daãn ñeán moät taäp tin khaùc vaøo
tröôøng kieåu kyù töï trong cöûa soå Browser.
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